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Overview

About this manual
This manual describes the installation and use of the DataCheckModule. 

Where appropriate, important information is displayed with a yellow background such as this.

Where information refers to a different section in this manual, this text is displayed with a 
green background, such as this.

About the application
The purpose of the DataCheckModule ('the application', hereafter) is to provide a coupling 
between scanned images and data extracted from the scanned material. Alternately, the 
application offers data entering or recoding facilities.

The application currently runs on Microsoft Windows XP operating systems.

The application requires a basic level of experience with Microsoft Windows operating systems. 
The user is required to navigate through the operating system's filesystem, and must possess 
a basic knowledge of how to activate menu-functions and open, close, and resize windows, 
with a standard computer mouse.

Application installation
The application installs as a ClickOnce application, wherefore it must be installed through a 
browser; preferably a Microsoft Internet Explorer browser. The client must activate an 'Install' 
button within the web-page the client is linked to, whereupon the following dialog will prompt 
the user to run the setup program which will install the application:
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The user must press “Run”, and also press “Run” in the context of the dialog following:

Another dialog will prompt the user to allow the installation:

Upon pressing “Install”, the application will downloaded from the Internet and installed on the 
user's computer:
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The application should now be available from the start-menu; select “Scanningsfabrikken” -> 
“DataCheckModule”.

Please note that running the application requires a working Internet connection.

Application uninstallation
To uninstall the application, simply remove it from the system by use of the standard Windows' 
“Add and Remove Programs” facility. Select the program entry and press “Change/Remove”:

Then press “OK” in the dialog following: 
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The application should proceed to uninstall itself.

Application security
The application requires that login- and password information be submitted before it may run. 
The following dialog will appear when the application is started:

As stated, enter valid credentials to continue. These will be given the client by 
Scanningsfabrikken. There is no 'Login'-button to press, as the application automatically logs 
the user in when the right combination of user ID and password are entered.
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Data
The data menu offers various methods of importing, deleting and saving data, as well as 
variables and records within the data sets and display areas.

Data sets
The application requires one or more data sets on which to operate. Therefore these must be 
imported into the application. 

Currently only SPSS data sets are supported by this application, though with a planned 
upgrade this will include Microsoft Excel and SAS data sets as well.

Adding a data set
Click “Add SPSS data set”, whereupon the following dialog box allows the user to browse to 
and select - by clicking 'Open' - the SPSS data set the user would like to import:

A new dialog will appear, which allows the user to give the data set a different name but the 
proposed, default name. 
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It is this name the data set will be known by, within the application. A secondary dialog 
appears, in which the user may opt to indicate a identification variable, which uniquely 
identifies the records within the data set:

If the data set indeed does contain a unique identification variable, such as a record-ID 
number, selecting this variable when the data set is imported into the application offers the 
user the possiblity to sort defined variable areas by this ID number. 

Please note it is not possible to later select a different identification variable beyond the data 
set import; if one such exist, and the user would like to be able to sort records by this ID 
variable, it must be selected now.

Deleting a data set
To delete a data set from the application, select “Delete data set”. The following dialog 
appears:

Select the data set you would like to delete from the drop-down list, and press “Delete the 
selected data set” to delete this. 

It is not possible to delete the data set which is currently active; to delete it, the user must 
first change to a different data set.

The user will be prompted to confirm the delete action: 
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As stated, deleting a data set removes all information about this, within the application. 

Deleting a data set within the application will not delete the file which was imported into the 
application.

Changing to a different data set
It is possible to import more than one data set into the application. To change between these, 
the user must select “Change data set” and select the data set which will then be the working 
data set: 

Save data set
The Save data set menu offers three methods of saving the working data set.

Save
Pressing the “Save” button saves the working data set to its temporary storage. This is akin to 
pressing the save-button in any other regular windows application, apart from the fact that the 
data set is saved to a pre-defined storage area, namely the operating system's ApplicationData 
folder. The user would typically press this button to ensure the performed changes are 
persisted to disk before a new set of changes are to be carried out.

Save as
The user can also press the “Save as” button to bring up a save-dialog where the user can 
navigate to a specific folder and save the data set under a specific name:
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Simply navigate to the proper directory and provide a name for the data set and press “Save”. 

Save slice
If the user so desires, a data set can be saved with only a subset - a 'slice' - of the currently 
working data set. This allows the user to save, for example, a data set with only responses 
from female respondents. Press “Save slice” and the following dialog appears:
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Press the folder-icon to open a save-dialog, where the user must navigate to the directory 
where he would like to save the file, and provide a valid filename:

Press the “Save” button to continue. Then, as the dialog states, provide one or more criteria 
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which the save function will honor. This dialog works in the same fashion as the advanced 
search feature

Refer to section “View” - “Advanced search” in this manual for information on how to add 
search criteria.

When the user is happy in the selection of criteria, she presses “Save data set”. The defined 
subset of the working data set will saved in the specified location.

Display areas
Display areas are used-defined areas within the scanned material, pertaining to a variable - a 
question within a questionnaire, for example - whose value is data captured from this area. 

Adding a display area
Click “Add display area”.

In order to define a display area, the application requires knowledge of the directory - or 
directories - which contains the images of the scanned material. If these are not defined, the 
user will be prompted to define these:

Refer to section “View” -  “Set image file directory” in this manual for information on how to 
define said image directories.

The following dialog will appear.
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In this dialog, the user defines one or more display areas by left-clicking with their mouse in 
the image area, and - keeping the left mouse button pressed - drawing a rectangle, moving 
the mouse towards the lower right bottom of the rectangle from its starting point of the upper 
left corner where the user clicked. 

It is possible to expand the dialog's size by performing a dragging-operation on the dialog 
window's lower right corner. 

If there are more than one image pertaining to a single record in the imported data set, as 
would be the case with a many-paged questionnaire, the dialog will display a drop-down list 
where the different pages can be selected.

The rectangle will be painted in a red color as it is being defined. When the mouse is released, 
the user must then select the variable whose value pertains to the area defined:
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Select a variable and provide a name for the diplay area (a default name will be given 
automatically) and press “Save display area” to persist the display area. The red color will turn 
either green or yellow, and the user may now define another variable area. 

Deleting a display area
To delete a previously defined display area, press “Delete display area”, and select the 
appropriate display area in the dialog box:

Press “Delete this area” and confirm the delete in the dialog following to delete this display 
area.

Saving display areas to a file
It is possible to persist defined display areas to a data file, so they may be saved for future 
use. 

Select “Save areas to file” and provide a file name for the data file:
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Press “Save” to save the display areas to a file with the given name. The file will be given the 
extention “daf”.

Loading display areas from a file
To load previously saved display areas, select “Load areas from file” and navigate to the data 
file from which the display areas will be loaded:
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Press “Open” and a dialog will appear, where the user may select the displays which will be 
loaded from the data file:

Pressing “Import selected areas” imports only the display areas whch are marked in the select-
list. Optionally the user can press “Import all areas”, to import all display areas. 

Note that if one or more display areas in the data file has the same name as an already 
defined display area, this display area will be hidden from the import dialog. 

Variables
The user may add or remove variables from the working data set. 

Adding a variable
To add a variable, select “Add variable”.  The following dialog appears:
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Enter a name for the variable, and specify its' variable type, numeric or string. Optionally 
specify a variable label. It is also possible to specify an new display area, based on an already 
defined display area, whose underlying data value will now point to this new variable. If the 
user chooses to create a new display area based on a previously defined area, a name for this 
area must be entered.

Press “Add variable” to add the new variable to the working data set.

Removing a variable
To remove a variable, select “Remove variable” and, in the dialog following, select the variable 
to remove. 
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Press “Remove selected variable” to remove this variable from the working data set.

Adding or removing variable value labels
The application supports adding or removing variable value labels, which will be saved with the 
data set. To add or remove a variable value label, select “Add/Remove value labels” and, in the 
following dialog, select an appropriate variable for this operation:

Press “Add/Remove value labels” and, in the dialog following, add or remove value labels 
where appropriate:
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To add a variable value label, enter its' value and a descriptive label in the two text-boxes and 
click “Add new variable value label”. The new value label will appear in the list below the “Add 
new variable value label”-button.

To remove a variable value label, mark this in the list and click “Remove variable value label”.

Press “Finished” to exit the dialog.

Records
Records pertain to the individual cases in the currently working data set.

Deleting a record
The user can delete a record in the currently working data set. In order to do so, a display 
area must be shown in the main window, and an individual area selected. 

Refer to the section “View” > “Select area” in this manual for information on how to show a 
display area in the main window.

Press “Delete current record”. The user will be prompted to confirm this choice. 
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View
The view menu offers functionality in the viewing and sorting/filtering/search of defined display 
areas.

Display Area
The display areas menu allows selection of a defined display area as well as the displaying of 
variable value labels.

Select area
Select a previously defined display area to view this in the application's main window:

Press “Display this area” to display this area. The main window will fill with the same number 
of areas as there are records in the working data set:
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The display areas line up in the order top-to-bottom, left-to-right. The user can select a display 
area - making it the 'active' display area - by left-clicking it. Making a display area the active 
display area allows a user to change its value. Simply enter a different value in the textbox 
immediately below the display area image.

Note the application status bar, displaying information about the currently working dataset: its' 
name, the title of the currently displayed display area, the current page number and total 
number of pages, and, where applicable, the unique record ID value of the currently active 
display area.

Show labels
The application supports the concept of variable value labels. If the imported data set holds 
information about value labels, these will have been carried over in the application's working 
data. The user can select to show these labels, instead of merely the variable value, by 
selecting “Show labels”. 

In this case, the main window will reflect the display area variable's value label, if one such has 
been defined:
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Also note than when value labels are displayed, the users goes about changing a display area's 
value differently: In this case, the user must click a mouse button - any which one - inside a 
display area, whereupon a drop-down list will appear, which will display all available values and 
their value labels, and allow the user to select the appropriate value:

It is still possible, however, to enter a value which is not represented in the drop-down list, by 
simple closing the dialog (by clicking the 'X' in its' upper right corner) and entering a different 
value.

Navigation
The navigation menu allows the user to navigate the currently working data set. Note that all 
navigation options are dependent on the user's choice of sorting, if one such choice has been 
made. For instance, if the user opts to sort the display areas by descending values, the highest 
values will be represented by the first page and the lowest by the last page. 
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Next page
The user can move one page forward by clicking the 'Next page' icon.

Previous page
The user can move one page backwards by clicking the 'Previous page' icon.

First page
The user can move to the first page by clicking the 'First page' icon.

Last page
The user can move to the last page by clicking the 'Last page' icon.

Zoom
The user can zoom in and out, as well as see the image on which a display area is based in its 
entirety.

Zoom in
Selecting 'Zoom in' when a display area has been selected has the effect of cropping the 
display area to minus 25% of its size. This change is permanent to the selected display area.

Zoom out
Similarly in function to 'Zoom in', zoom out affects the display with 25%, only in this case 
expanding the size. This change is permanent to the selected display area.

View original image
There may be times when the user would like to inspect a area greater than what the display 
area covers; for instance, in cases where a form's respondent has written relevant text around 
the question he or she has answered. In this case, selecting 'View original image' displays the 
entire image from which the currently active display area has been extracted:
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The user can adjust the size of the window by moving the mouse to the lower left corner and, 
clicking the left mouse-button and keeping it pressed, dragging the window bigger. The image 
will automatically adjust to the window size.

Sort
Sorting the display area values can greatly speed up the quality control phase, in cases where 
the software is being used for this purpose.

Sort ascending
Select 'Sort ascending' to sort the display areas by their values, in ascending order. The main 
window will reload and display the areas, now with the lowest values listed first.

Sort descending
Select 'Sort descending' to sort the display areas by their values, in descending order. The 
main window will reload and display the areas, now with the higest values listed first.

Sort by record ID
Select 'Sort by record ID' to sort the display areas by the unique identification variable the 
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user selected when the data set was originally imported into the application. If no such 
variable has been selected in the data set import process, this function will not be available.

Do not be fooled by the sort order if a string variable is selected as a unique identification 
variable; in this case, the application will rightly sort values by their string value, and not their 
numeric value. Thus, if the identification variable contains string representations of the integer 
values 1 to 12, the correct sort order will be 1, 10, 11, 12, 2, 3, 4, 5, 6, 7, 8, 9. In other 
words, if the unique identification variable consists solely of integer values, ensure its variable 
type is numeric, and not a string.

Search
The user can search for a value or sets of values and thus filter the display areas and show 
only the values as defined by this search. This greatly speeds up the quality control use of the 
application, as the user can filter out records deemed irrelevant for further check.

Simple search
Selecting 'Simple search' allows space in the main window for a search tab with two drop-down 
lists, 'From' and 'To', designating the range within which a search will be executed:

The 'From' and 'To' drop-down lists are populated with the unique values of the currently 
selected display area's variable. Select a relevant 'From' and 'To' value and click 'Search'; the 
search will be executed, and only the records with values within the given range will be 
displayed. 

Note how the status bar in the bottom of the main window changes to reflect the fewer 
number of pages, as the search limits the number of available records.
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Note also that it is still possible to make use of the sorting possiblities within the context of a 
searched/filtered data set.

The 'Simple search' menu-item will be highlighted in red, to account for the fact that the 
simple search has been activated. To return to the regular view, click the button once more, 
thus deactivating the simple search tab.

Advanced search
Another search option is the advanced search, activated by selecting the 'Advanced search' 
button. An advanced search allows the user to specify one or more search criteria, upon which 
the currently working data set may be filtered. For example by setting up a criteria specifying 
only responses by female respondents below the age of 30 are shown.

The main window allows room for an advanced search tab:

Press 'Add criteria' to add a search criteria. The following dialog allows the user to define a 
search criteria.
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Form the search criteria by selecting variable, the operator and the value of the criteria. Note 
that if the imported data set contains variable value labels, these are also displayed to ease 
the definition. As the criteria is formed, the text label below the drop-down lists updates with 
the criteria definition. 

Note that if the user selects a string variable upon which to base the criteria, the 'select value' 
drop-down list will change into a text-box, where the user may enter a text as opposed to a 
numeric value.

Press 'Add criteria' to add the criteria expression. The search tab will update to display the 
expression as well as list the number of records the expression narrows the current working 
data set down to:

Add more expressions by pressing the 'Add criteria' button, where applicable.
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The user can remove the criterias in order of how they were added, by pressing the 'Remove 
last criteria' button one or several times.

Press 'Perform search' to execute the filtering and show only those records who fit the defined 
search criteria.

Note how the status bar in the bottom of the main window changes to reflect the fewer 
number of pages, as the search limits the number of available records.

Note also that it is still possible to make use of the sorting possiblities within the context of a 
searched/filtered data set.

The 'Advanced search' menu-item will be highlighted in red, to account for the fact that the 
advanced search has been activated. To return to the regular view, click the button once more, 
thus deactivating the advanced search tab.

Settings
In the settings-menu, the user defines one or more settings which affect how the display areas 
are shown.

Set image files directory
In order to show the display areas, the application must know where to locate the scanned 
images these areas are based upon. One or more image directories can be defined for the 
working data set.

Select 'Set image files directory' to define the image directories for the data set. The following 
dialog appears:

Press 'Add directory' to bring up a directory chooser:
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Browse to and select a directory with scanned image files by clicking 'OK'. The directory will 
appear in the “Add image files directories” dialog. Add more image directories by clicking 'Add 
directory' one or more times. 

Alternately, press the 'Remove selected' button to remove the selected image directory in the 
list, thus disabling the application from searching through this directory for the image files the 
application requires. Note that only the application's reference to the directory, and not the 
directory itself, is removed.

When finished, press 'OK' to return to the application's main window.

Define rows and columns
Press 'Define rows and columns' to define how many display areas are shown in the main 
window, and how the are laid out. This brings up the following dialog:
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Operate the sliders to allow for more, or fewer, columns and rows. 

Press 'OK' to exit the dialog. If the number of columns or rows has been adjusted, the main 
window will reload to reflect the changes.

Set border color
Press 'Set border color' to bring up a color-picker dialog, where the user may select a different 
border color around the currently active display area. The default border color is yellow.

The dialog displays standard colors. Press “Define custom color” to expand the dialog to allow 
for a different way of selecting color, by moving the mouse in a rainbow-squere, alternatively 
enter the RGB color codes manually:
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Functions
The functions menu offers different helper-functionality.

Analyze
The analyze menu provides - currently - a single analyze-function. 

Table of frequencies
Pressing 'Table of frequencies' when a display is selected brings up a window which displays 
information about the values of the currently selected display area's variable, namely their 
count in regular and percentages value:

The window gives a quick overview of how the registrered values of the variable are 
represented throughout the data set.

The user can sort the columns by clicking one of the datagrid headers - 'Value'/'Count'/'%' - 
with the left mouse button. 

Note the window is not modal, unlike most of the dialog windows of this application. This 
means the window may remain open while the user uses the application, possibly editing the 
values of the shown display areas. By pressing  the 'Update frequencies'-button, the datagrid 
is updated with information from the working data set, including any changes the user may 
have made to it.

Press 'OK' to exit the dialog.
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Edit
The Edit menu offers undo functionality.

Undo
The user may opt to undo one or more change made to the currently selected display area. 

Select 'Undo'. The following window appears:

The window will initially show changes made to the currently shown display area. The user can 
select a different variable in the drop-down list in the top left corner of the window. Please 
note that not all variables of the working data set are displayed; only display areas with 
variables which has had changes made to their values are listed in the drop-down list. 

The user may optionally filter the changes per user, or 'all users' (the default selection). 

The window shows the display area which had a change made to it. The label directly below 
the display area states the number of registrered changes made to the shown area. Note that 
only one change will be registrered per display area. That is, if the user changes the value of 
the same display area two or more times, only the last of these changes will be available for an 
undo operation.

The user may nagivate through the changes by clicking the 'Previous change' and 'Next 
change' buttons, respectively. 

Below the navigation buttons, a label states in layman's terms which change was made, as 
well as when the change was made. 

To undo the change, click the 'Undo this change' button. The change will be rolled back. 

Press 'Close' to exit the window.

If one or more changes have been undone, the main window will reload to reflect this 
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operation.

Misc.
The 'Misc.' menu hosts functionality which does not fit in with any other menu category. 

Take snapshot
The user my click the 'Take snapshot' menu item to bring up a save-dialog. The purpose of this 
dialog is to offer the possibility to save an image of the currently active display area, in the 
JPEG graphics format, on the user's computer for future reference. This may be of use where 
the display area displays an open question, for example in question in a questionnaire where 
the user may respond in her own words.

If a unique identifier variable was selected upon the data set's import into the application, the 
value of this variable will appear in bold red characters in the top left corner of the image.

Refer to section 'Data' > 'Add SPSS data set' on how to import an SPSS data set and, in the 
process, select a unique identifier variable.

About
The about menu item offers, when clicked, basic contact-information in regards to application 
support. 
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User Administration

Add/Delete
The Add/Delete menu block offers basic user-control functionality; adding a user, activating or 
deactivating this user.

A company licencing the application will be provided with an administration user ID and 
corresponding password. The designated administrator can optionally add up to three users 
with non-administrative rights. These may use the application without any restrictions 
compared to the administrative user, with the sole exception that they cannot administer other 
users. The menu will only appear to the administrative user.

The benefit of adding users with their distinctive user id and password is in that all changes 
made to the display areas' values are registrered per user, wherefore it becomes possible to 
filter any changes made by this user. 

Refer to the section 'Functions' > 'Undo' on how to filter changes made by an individual user. 

Add user
Select the 'Add user' button to add a user. The following dialog appears:

Fill out all available textboxes with relevant information and click 'Add new user' to add the 
user. 

It is recommended that the selected password is a minimum of 8 characters in length, 
preferably consisting of a mix of upper- and lower-case characters as well as digits.

A new user is automatically activated to access the application.
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Deactivate user
The administrator may opt to deactivate a user, thus preventing this user from accessing the 
application.

Select 'Deactivate user'. The following dialog appears:

Select in the drop-down list the user who will be deactivated, and press 'Deactivate user'. The 
user will be deactivated, and a confirmation message will appear and state this user has been 
locked out.

Activate user
The administrator may opt to re-activate a user who has been previously deactivated. Press 
'Activate user' and select, in the drop-down list on the appearing form, the user who will be 
activated. 

Press 'Activate user' and a confirmation message will appear and state this user may not again 
access the application with her credentials.
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